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Preface

INTRODUCTION
This chapter contains general information that will be useful to know before using the 
ATA6847L QFN48 BLDC Motor Driver Evaluation Board. Items discussed in this 
chapter include:
• Document Layout
• Conventions Used in this Guide
• Recommended Reading
• The Microchip Website
• Development Systems Customer Change Notification Service
• Customer Support
• Document Revision History

DOCUMENT LAYOUT
This document describes how to use the ATA6847L QFN48 BLDC Motor Driver 
Evaluation Board. The manual layout is as follows:
• Chapter 1. “Product Overview” – Important information about the ATA6847L 

QFN48 BLDC Motor Driver Evaluation Board. 
• Chapter 2. “Installation and Operation” – Includes instructions on installing and 

using the ATA6847L QFN48 BLDC Motor Driver Evaluation Board.
• Appendix A. “Schematics and Layouts” – Shows the schematic and layout

diagrams for the ATA6847L QFN48 BLDC Motor Driver Evaluation Board.
• Appendix B. “Bill of Materials (BOM)” – Lists the parts used to build the 

ATA6847L QFN48 BLDC Motor Driver Evaluation Board.
• Appendix C. “Software” – Provides information about the demo application and 

where the source code can be found.

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and 
documentation are constantly evolving to meet customer needs, so some actual dialogs 
and/or tool descriptions may differ from those in this document. Please refer to our website 
(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each 
page, in front of the page number. The numbering convention for the DS number is 
“DSXXXXXXXXA”, where “XXXXXXXX” is the document number and “A” is the revision level 
of the document.

For the most up-to-date information on development tools, see the MPLAB® IDE online help. 
Select the Help menu, and then Topics to open a list of available online help files.

https://www.microchip.com/
https://www.microchip.com/
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CONVENTIONS USED IN THIS GUIDE
This manual uses the following documentation conventions:

DOCUMENTATION CONVENTIONS
Description Represents Examples

Arial font:
Italic characters Referenced books MPLAB® IDE User’s Guide

Emphasized text ...is the only compiler...
Initial caps A window the Output window

A dialog the Settings dialog
A menu selection select Enable Programmer

Quotes A field name in a window or 
dialog

“Save project before build”

Underlined, italic text with 
right angle bracket

A menu path File>Save

Bold characters A dialog button Click OK
A tab Click the Power tab

N‘Rnnnn A number in verilog format, 
where N is the total number of 
digits, R is the radix and n is a 
digit.

4‘b0010, 2‘hF1

Text in angle brackets < > A key on the keyboard Press <Enter>, <F1>
Courier New font:
Plain Courier New Sample source code #define START

Filenames autoexec.bat

File paths c:\mcc18\h

Keywords _asm, _endasm, static

Command-line options -Opa+, -Opa-

Bit values 0, 1

Constants 0xFF, ‘A’

Italic Courier New A variable argument file.o, where file can be 
any valid filename

Square brackets [ ] Optional arguments mcc18 [options] file 
[options]

Curly brackets and pipe 
character: { | }

Choice of mutually exclusive 
arguments; an OR selection

errorlevel {0|1}

Ellipses... Replaces repeated text var_name [, 
var_name...]

Represents code supplied by 
user

void main (void)
{ ...
}
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RECOMMENDED READING
This user's guide describes how to use the ATA6847L QFN48 BLDC Motor Driver 
Evaluation Board. Other useful documents are listed below. The following Microchip 
documents are available and recommended as supplemental reference resources:
• ATA6847L Data Sheet - “3-Phase Motor Gate Driver System Basis Chip with 

Power Module, Sleep Mode, and LIN Transceiver” (DS20006940) – This data 
sheet provides detailed information regarding the ATA6847L product family.

• dsPIC33CK256MP508 Data Sheet - "Digital Signal Controllers with 
High-Resolution PWM and CAN Flexible Data (CAN FD)" (DS70005349) - This 
data sheet provides detailed information regarding the dsPIC33CK256MP205 
product family.

• dsPIC33E/PIC24E Family Reference Manual (DS70573)
•  dsPIC33AK128MC106 Family Data Sheet -  "High-Performance dsPIC33A 

Core with Floating-Point Unit, High-Speed ADCs and High-Resolution PWM" 
(DS70005539) - This data sheet contains anomalies and clarifications for the 
dsPIC33AK128MC106 processor.

• SAM C21 Family Data Sheet -"32-bit Arm Cortex-M0+ with 5V Support, 
CAN-FD, PTC, and Advanced Analog" (DS60001479) - This data sheet 
contains anomalies and clarifications for the ATSAMC21J18A processor.

• AN1078 - “Sensorless Field Oriented Control of a PMSM” (DS01078)
• AN1160 - “Sensorless BLDC Control with Back-EMF Filtering Using a 

Majority Function” (DS01160)
• AN992 - “Sensorless BLDC Motor Control Using dsPIC30F2010” (DS00992)
• AN1292 - “Sensorless Field Oriented Control (FOC) for a Permanent Magnet 

Synchronous Motor (PMSM) Using a PLL Estimator and Field Weakening 
(FW)” (DS01292)

• AN901 - “Using the dsPIC30F for Sensorless BLDC Control” (DS00901)

THE MICROCHIP WEBSITE
Microchip provides online support via our website at www.microchip.com. This website 
is used as a means to make files and information easily available to customers. 
Accessible by using your favorite Internet browser, the website contains the following 
information:
• Product Support – Data sheets and errata, application notes and sample 

programs, design resources, user’s guides and hardware support documents, 
latest software releases and archived software

• General Technical Support – Frequently Asked Questions (FAQs), technical 
support requests, online discussion groups, Microchip consultant program 
member listing

• Business of Microchip – Product selector and ordering guides, latest Microchip 
press releases, listing of seminars and events, listings of Microchip sales offices, 
distributors and factory representatives

www.microchip.com
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DEVELOPMENT SYSTEMS CUSTOMER CHANGE NOTIFICATION SERVICE
Microchip's customer notification service helps keep customers current on Microchip 
products. Subscribers will receive an e-mail notification whenever there are changes, 
updates, revisions or errata related to a specified product family or development tool of 
interest.
To register, access the Microchip website at www.microchip.com, click on Customer 
Change Notification and follow the registration instructions.
The Development Systems product group categories are:
• Compilers - The latest information on Microchip C compilers, assemblers, linkers 

and other language tools. These include all MPLAB C compilers; all MPLAB 
assemblers (including MPASM assembler); all MPLAB linkers (including MPLINK 
object linker); and all MPLAB librarians (including MPLIB object librarian).

• Emulators - The latest information on Microchip in-circuit emulators.This includes 
the MPLAB REAL ICE™ and MPLAB ICE 2000 in-circuit emulators.

• In-Circuit Debuggers - The latest information on the Microchip in-circuit 
debuggers. This includes MPLAB ICD 3 in-circuit debuggers and PICkit 3/4 
Debug Express.

• MPLAB IDE - The latest information on Microchip MPLAB IDE, the Windows 
Integrated Development Environment for development systems tools. This list is 
focused on the MPLAB IDE, MPLAB IDE Project Manager, MPLAB Editor and 
MPLAB SIM simulator, as well as general editing and debugging features.

• Programmers - The latest information on Microchip programmers. These include 
production programmers such as MPLAB REAL ICE in-circuit emulator, MPLAB 
ICD 3 in-circuit debugger and MPLAB PM3 device programmers. Also included 
are nonproduction development programmers such as PICSTART Plus and PICkit 
2, 3 and 4 programmers.

CUSTOMER SUPPORT
Users of Microchip products can receive assistance through several channels:
• Distributor or Representative
• Local Sales Office
• Field Application Engineer (FAE)
• Technical Support
Customers should contact their distributor, representative or field application engineer 
(FAE) for support. Local sales offices are also available to help customers. A listing of 
sales offices and locations is included in the back of this document.
Technical support is available through the website at: 
http://www.microchip.com/support.

DOCUMENT REVISION HISTORY

Revision A (July 2025)
• Initial release of this document.

http://www.microchip.com/support
http://www.microchip.com/support
www.microchip.com
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Chapter 1.  Product Overview

1.1 INTRODUCTION
This chapter covers the following topics:
• ATA6847L QFN48 BLDC Motor Driver Evaluation Board Overview
• What is the ATA6847L QFN48 BLDC Motor Driver Evaluation Board?
• What does the ATA6847L QFN48 BLDC Motor Driver Evaluation Board Kit 

Include?

1.2 ATA6847L QFN48 BLDC MOTOR DRIVER EVALUATION BOARD OVERVIEW
The ATA6847L QFN48 BLDC Motor Driver Evaluation Board is used to demonstrate 
the driver capabilities offered by the ATA6847L variant with LIN and a VIO voltage of 
3.3V in BLDC/PMSM motor applications.
The two-layered, high current board is designed to be very versatile, low cost, and 
easily configurable to meet as many customer preferences as possible. It uses the 
ATA6847L QFN48 as a 3-phase Brushless DC (BLDC) motor gate driver and the 
dsPIC33CK256MP205 Motor Control DIM provided by Microchip. In order to implement 
different types of algorithms, like the sinusoidal dual/single shunt FOC or the 
trapezoidal motor control algorithm in sensored or sensorless mode, the board can be 
easily configured by using the jumpers and connectors located on the board. 
Furthermore, the desired firmware should be implemented accordingly to the desired 
hardware configuration.
As provided, the ATA6847L QFN48 BLDC Motor Driver Evaluation Board is ready to 
drive a BLDC motor using the FOC method in sensorless mode. The board is equipped 
with a Start/Stop button and a potentiometer that can be used to adjust the speed of the 
motor. The evaluation board can drive a BLDC motor with a supply voltage of up to 
32.5V and a motor current up to 35A RMS. For higher load currents, a custom heat sink 
can be attached on the bottom side. The ATA6847L QFN48 BLDC Motor Driver 
Evaluation Board provides user selectable 3.3V/5V/100 mA LDOs, a 3.3V Buck 
Regulator, a LIN communication interface, a USB Serial connection, a MikroE 
connector, an Xplained Pro extension header, three current sense operational 
amplifiers, and Hall-effect sensors inputs. Moreover, the ATA6847L has many 
configuration capabilities for OCP/Limit, Overvoltage, Undervoltage, Overtemperature 
protections due to its internal dedicated registers that are available via its SPI interface.    
Several key test points are available on the board in order to facilitate the user's 
measurements, tuning or motor control optimization.
The evaluation board provides several optical indicators, such as RunLED, FltLED for 
the status indication, PwLED for voltage presence, VDD1 and VDD2 for LDO voltage 
presence, RX and TX indication of serial connection to computer and six on-board 
LEDs for Pulse-Width Modulation (PWM) inputs.
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1.3 WHAT IS THE ATA6847L QFN48 BLDC MOTOR DRIVER EVALUATION 
BOARD?

The ATA6847L QFN48 BLDC Motor Driver Evaluation Board is a complete motor con-
troller for brushless DC motors (BLDC). The board can drive a three-phase brushless 
DC motor rated at up to 35A and 32.5V. The input voltage motor operating range for 
the board is +4.9V to +32.5V. The board consists of three main units:
• ATA6847L QFN48 Motor Driver
• DIM connector to attach one of the compatible motor control DIMs, like 

dsPIC33CK256MP205 Motor Control DIM.
• Three phases MOSFET Bridge

FIGURE 1-1: ATA6847L QFN48 BLDC Motor Driver Evaluation Board Block 
Diagram.
The on-board ATA6847L generates 3.3V using internal voltage regulators (VDD2) for 
the attached host microcontroller (or 5V for other microcontroller type/Hall sensors). 
The ATA6847L also contains two charge pumps for the low and high side of the Gate 
Driver Unit to allow operation up to 100% duty cycle.
A LIN communication interface included by ATA6847L gives the possibility for external 
systems interfacing that use this communication protocol.
An input terminal block connector is provided to apply the input voltage to the board, 
and another output connector is provided to attach the BLDC. 
A programming header connector is available for programming/updating the firmware 
contained in the dsPIC33CK256MP205 from the motor control DIM, using a PICkit 
programmer/debugger.
An input terminal block is supplied on the board, to allow users to connect the Hall 
sensors with selectable voltage supply (5V/3.3V).
Four push buttons (RST, PB1, RUN and WAKE) are available for different events 
generation (as start, stop, direction change, reset, etc). A reference speed 
potentiometer is available to set the desired motor velocity.
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An optional spare buck power supply is available for ATA6847-3333L which has INH 
signal for external source activation or for external interfaces if the required current 
exceeds the device capability.
Finally, the PCB layout design can serve as a reference example for a robust, low-cost, 
two-layered, low-voltage, high-current board.

1.4 WHAT DOES THE ATA6847L QFN48 BLDC MOTOR DRIVER EVALUATION 
BOARD KIT INCLUDE?

The ATA6847L QFN48 BLDC Motor Driver Evaluation Board kit includes:
• The ATA6847L QFN48 BLDC Motor Driver Evaluation Board (EV92R69A).
• The dsPIC33CK256MP205 Motor Control DIM (EV53A92A).



ATA6847L
 QFN48 BLDC MOTOR DRIVER

 EVALUATION BOARD
 USER’S GUIDE

 2025 Microchip Technology Inc. and its subsidiaries DS50003904A-page 12

Chapter 2.  Installation and Operation

2.1 INTRODUCTION
The ATA6847L QFN48 BLDC Motor Driver Evaluation Board demonstrates the 
features of Microchip's 3-Phase Brushless DC (BLDC) Motor Driver with Power 
Module, ATA6847L, used in a BLDC motor driver application. When used in conjunction 
with a microcontroller, the ATA6847L will provide the necessary drive signals to drive a 
3-Phase BLDC motor.
The ATA6847L contains all necessary functional blocks for developing high 
performance BLDC/PMSM motor drivers: high and low side MOSFET drivers, three 
gain/offset configurable Op Amps, protection circuity and SPI interface for the 
configuration of the internal registers. 
The board is equipped with a DIM slot for one of Microchip’s motor control DIMs and is 
compatible with dsPIC33CK256MP205 Motor Control DIM high performance Digital 
Signal Controller (DSC) and can handle simple motor control algorithms like the 
six-step or high-performance algorithm like the Field Oriented Control (FOC). The 
dsPIC (DSC) present on the Motor Control DIM is used to provide the PWM inputs to 
the ATA6847L as well as handle the high-speed Analog-to-Digital Conversion (ADC) 
supporting up to 50 kHz PWM operation for the FOC motor control technique or higher 
for trapezoidal. The microcontroller supports a large range of motor control applications 
due to its specific synchronization between different peripherals. 
The motor current can be measured using the dual or single shunt techniques 
described in AN1078. A high-performance current sense amplifier is implemented 
using two/three of the ATA6847's internal Op Amps. The third internal OPAMP can be 
configured either as BEMF or current sense amplifier.

2.2 FEATURES
The ATA6847L QFN48 BLDC Motor Driver Evaluation Board has the following 
features:
• Input operating voltage range: 4.9V to 32.5V
• Maximum of 10/27Ω of gate drive sink/source resistance for external N-Channel 

MOSFETs and programmable LS/HS slew rate control: 12.5%, 25%, 50%, 100%
• Drives up to a 35A RMS BLDC motor
• Three programmable gain/offset current sense amplifiers (G = 8, 16, 32, 64)
• ON/OFF push button (RUN)
• Reset push button (RST)
• PB1 user-programmable push button (µC/Wk)
• Wake-up push button
• PWM signal LED indicators
• Fault signal LED indicator
• IRQ signal LED indicator
• PICkit debugger interface
• Speed control potentiometer
• Terminal block for 3.3V and 5V Hall-effect sensors
• UVLO, OVLO and DUVLO protections
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• Programmable external MOSFET overcurrent protection 125 mV to 1.75V
• Programmable PWM dead-time protection 100 ns to 6.3 µs (100 ns step)
• Thermal shutdown protection
• Programmable timing filters for current and voltages
• Complete “C” source code (provided on the Motor Driver Evaluation Board 

webpage)

2.3 GETTING STARTED
The ATA6847L QFN48 BLDC Motor Driver Evaluation Board is fully assembled and 
tested for driving a BLDC motor. The board can be easily configured to drive a BLDC 
motor in sensored or sensorless mode, as well as for sinusoidal single shunt FOC or 
trapezoidal motor control algorithm.
The board requires the use of an external voltage source capable of supplying 4.9V to 
32.5V at the rated motor current. The board is presented in Figure 2-1. The 24V, 
3-phase, AC300022 BLDC Motor is also required to evaluate the motor driver.

FIGURE 2-1: ATA6847L QFN48 BLDC Motor Driver Evaluation Board PCB 
(Top).
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FIGURE 2-2: ATA6847L QFN48 BLDC Motor Driver Evaluation Board PCB 
(Bottom).

2.3.1 Connections

2.3.1.1 JUMPER SETTINGS

The ATA6847L QFN48 BLDC Motor Driver Evaluation Board has several 
user-configurable jumpers. The jumpers are described in Table 2-1 below. The 
configuration jumpers positioning is illustrated in Figure 2-3:

TABLE 2-1: ATA6847L QFN48 BLDC MOTOR DRIVER EVALUATION BOARD JUMPERS
Jumper Positions Function Description

JpRst2 On/Off Connect/Disconnect MCLR and nRST signals (for WDT operation)
J5,7,9 BMFx/OAx BMF block signals/OpAmp1 hardware configuration
R55/R66/R67 5V/12V/3.3V 5V/12V/3.3V Hall power voltage selection
Jp11 On/Off Connect / Disconnect LIN bus to an external Battery
Jp13 On/Off Connect / Disconnect LIN bus to Commander LIN capacitor
J2 VDD2/INH Route VDD2 to DSP PwS or INH to Auxiliary Buck (ATA6847-3333L). 

Do not place the jumper if powered from the buck.
J11 3V3/5V Power microcontroller with 3.3V or 5V
R54 SMD Resistor 0Ω Populate if auxiliary buck is used and J2 = INH or not placed
R113 SMD Resistor 0Ω Populate if the surface mounted NTC "TH1" is used
R20/R69 On/Off Connect/Disconnect IRQ line
R70/R97 On/Off Connect/Disconnect MISO line
R94/R98 On/Off Connect/Disconnect MOSI line
R72/R96 On/Off Connect/Disconnect SCK line
R73/R99 On/Off Connect/Disconnect LIN_RX line
R100/R101 On/Off Connect/Disconnect LIN_TX line
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FIGURE 2-3: ATA6847L QFN48 BLDC Motor Driver Evaluation Board Jumpers 
Positioning.

FIGURE 2-4: ATA6847L QFN48 BLDC Motor Driver Evaluation Board 
Features.

The board can be easily configured for different types of motor and control algorithms:
• BLDC Trapezoidal sensorless based on B-EMF null cross detection
• BLDC Trapezoidal based on sensor position detection
• PMSM, FOC, three shunt sensorless (with/without wind milling)
• PMSM, FOC, three shunt based on sensor position detection
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Table 2-2 describes the jumpers’ settings, for different motor control modes.

For the same motor, Figure 2-5 shows the currents for sensorless trapezoidal and 
sensorless sinusoidal modes, taken on this board.

FIGURE 2-5: Trapezoidal and Sinusoidal Motor Control Modes.

Pressing the Sw1 (WAKE) push button wakes the system up.
Pressing the ST3 (RST) push button forces a host controller reset.

TABLE 2-2: HARDWARE MOTOR CONTROL MODE SETUP
Jumper Positions  Description

Trapezoidal Sensorless Mode
J5 BEMF3 Route OPO1 as BEMF3 ZCD output to DSC 
J7 BEMF2 Route OPP1 as BEMF2 ZCD output to DSC 
J9 BEMF1 Route OPN1 as BEMF1 ZCD output to DSC 

FOC Sinusoidal Sensorless Mode
J5 IO1 Route OPO1 CSA output to DSC 
J7 In1+ Route OPP1 as CSA to IS+ 
J9 In1- Route OPN1 as CSA to IS-

Trapezoidal Sensored Mode
R67
or

R55
or

R66

HALL 3.3V

HALL 5V

HALL 12V

Route 3.3V to power Hall sensors

Route 5V to power Hall sensors

Route 12V to power Hall sensors

FOC Sinusoidal Sensored Mode
J5 IO1 Route OPO1 CSA output to DSC 
J7 In1+ Route OPP1 as CSA to IS+ 
J9 In1- Route OPN1 as CSA to IS-

R67
or

R55
or

R66

HALL 3.3V

HALL 5V

HALL 12V

Route 3.3V to power Hall sensors

Route 5V to power Hall sensors

Route 12V to power Hall sensors

------ Phase Voltage
------ Phase Current
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Jp11 and Jp13 are used to pull up LIN to the external battery voltage and to add a LIN 
commander capacitor, respectively.
J2 is dedicated for the VDD2/INH pin and, when the board is equipped with the 
ATA6847-3333L, must be put in INH (right) position, to be used as external power 
supply activator (the second LDO is not available for this variant). At the same time, 
R54 (0Ω) has to be populated to tie the external power supply output to the +3.3V line, 
in order to supply the dsPIC33CK256MP205 Motor Control DIM.
The INH jumper should be skipped if R51 - Enable PullUp - is present on the board.

FIGURE 2-6: Evaluation Board Power Supply Diagram.

2.3.1.2 AVAILABLE INTERFACING CONNECTORS
For external board interfacing and communication, the following connectors are 
available: 
• J3 is dedicated for microcontroller programming/debugging. After programming, it 

can be used for other purposes, e.g. for rotary encoder interfacing, due to the 
microcontroller pin remapping feature.

• J_M is the motor driver output. This is the connection to the BLDC motor.
• J10 is the power supply connection. The board needs to be connected to a power 

supply with an output range of 4.9 to 32.5V, according to the voltage ratings of the 
motor utilized by the user.

• J4 connects the Hall effect sensors to the dsPIC33CK256MP205 microcontroller. 
Before connecting the Hall effect sensors, the user must make sure that the Hall 
effect sensors are powered with the right voltage by putting the 0R resistor in 
location R67 for 3.3V, in location R55 for 5V or in location R66 for 12V.

Interface Connectors
• J10 (VPwS) input power supply connector.

• JM (MOTOR) three phases output connector.

ATA6847

LDO
VDD2

LDO
VDD1

Buck EN
R54

R51

4.9 .. 32.5V

J2

Motor Control 
DIM

R

5V

3.3V

VIO

0ohm 100k

Mosfet 
Bridge

4

Pin Name Description 
1 GND Power Supply Ground
2 VPwS +Power Supply Voltage

Pin Name Description 
1 A Motor A phase
2 B Motor B phase
3 C Motor C phase
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• J3 (PICKITProg) is mainly dedicated for microcontroller programming/debugging.

• J6 (Sensors) Hall sensors interfacing connector. Could be used also for other 
interfacing sensors, e.g. QEI).

• J8 (LIN) can be used to communicate with external systems based on LIN 
protocol or for external Wakeup command when SLEEP mode was induced. 

2.3.1.3 POWERING THE ATA6847L QFN48 BLDC MOTOR DRIVER 
EVALUATION BOARD

• Apply the input voltage to the input power terminal block, VB, with respect to 
polarity. The input voltage source should be limited to +32.5V. For proper 
operation with a common motor, the input voltage should be between +4.9V and 
+32.5V, in concordance with the motor rated voltage. Connect the positive side of 
the input power source (+) to pin 1 of VB. Connect the negative or return side (-) 
of the input source to pin 2 of VB. Refer to Figure 2-3.

2.3.1.4 CONNECTING A MOTOR TO THE ATA6847L QFN48 BLDC MOTOR 
DRIVER EVALUATION BOARD

• Connect each phase winding of a three-phase BLDC motor to the appropriate 
terminal of the motor terminals (PhA, PhB, PhC).

2.3.2 Operating a Motor
1. Turn the SPEED adjust potentiometer (RV1) fully counterclockwise to obtain the 

slowest speed setting. Now turn the speed adjust approximately ¼ turn 
clockwise to allow for 25% motor speed.

2. Turn on the power supply. At this moment, the red Fault LED is blinking at around 
10 Hz.

3. Press and release the RUN push button (ST1) to start the motor. In this moment, 
the PWM's LEDs indicate the motor powering.

4. Turn the Speed potentiometer clockwise to increase motor speed and 
counterclockwise to decrease motor speed. The Speed Adjust changes the 
PWM duty cycle of the PWM signals being sent to the ATA6847L.

5. Press and release the RUN push button again to stop the motor.

Pin Name Description 
1 MCLR UART Output (from USB to MCU)
2 VPP +3.3V Power-programming
3 VSS Microcontroller GND
4 PGD Programming Data
5 PGC Programming Clock
6 Aux Not used
7 TDI Not used
8 TMS Not used

Pin Name Description 
5 VH- Hall GND
4 VH+ Hall power supply +3.3/5V/12V
3 HallA HallA sensor output
2 HallB HallB sensor output
1 HallA HallA sensor output

Pin Name Description 
1 VBAT External battery LIN biasing
2 LIN LIN bus signal 
3 GNDLIN LIN ground reference
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2.3.3 Indicator LEDs
The ATA6847L QFN48 BLDC Motor Driver Evaluation Board has eight LEDs to indicate 
system status. Table 2-3 lists the LED indicators and their description.

2.3.4 Test Points
There are several test points on the board that allow probing of voltages, currents and 
signals (see Table 2-4).

TABLE 2-3: LED INDICATORS
PCB Location Name Description

D1, D3, D5 PWMxL PWM Phase x low – side
D2, D4, D6 PWMxH PWM Phase x high – side

D8 VPw Indicates power supply presence
D21 Run Motor running state
D20 Flt Fault Indicates FAULT status

D22 LH Optical indicator for Limp Home, VDD independent high voltage 
failure output

D24 GPIO1 LED connected to debugging pin. Used by user for code 
debugging purposes

D26 nIRQ Indicates nIRQ status
D27 RX Data activity received by MCP2221A on RX line
D28 TX Data activity transmitted by MCP2221A on TX line
D29 VDD1 Presence of voltage on the VDD1 line
D30 VDD2 Presence of voltage on the VDD2 line
D31 NCS Indicates chip select status

D32 GPIO2 LED connected to debugging pin. Used by user for code 
debugging purposes.

TABLE 2-4: TEST POINTS DESCRIPTION
Test Point Name Description

+4.9…32V Power supply (+)
GND Power supply ground (-)
VDD2 3.3V LDO output voltage
VDD1 5V internal LDO output
VIO Microcontroller supply voltage
VG12 12V internal low side LDO output
CPP1 Charge Pump Positive 1
CPP2 Charge Pump Positive 2
VCP Output Charge Pump 2 output (respect with VDH)
MOSI SPI Host Output Client Input
MISO SPI Host Input Client Output
SCK SPI Serial Clock
NCS SPI Chip Select
IRQ Interrupt request
IL1...3 PWMs Low driver inputs
IH1...3 PWMs High driver inputs
GL1...3 A/B/C Phase Low driver outputs
GH1...3 A/B/C Phase High driver outputs
SH1...3 A/B/C motor/driver phase signals
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2.3.5 Reprogramming the dsPIC33CK256MP205 Motor Control DIM
The dsPIC33CK256MP205 Motor Control DIM can be reprogrammed with the user's 
desired firmware. The processor may be programmed by using an external power 
source and a PICkit 3, MPLAB REAL ICE in-circuit emulator, PICkit 4 or PICkit 5 
programmer.
1. Connect the power source to the board, as explained in Section 2.3.1.3
2. Connect a PICkit 3, PICkit 4, or PICkit 5 to the J3 header
3. Start up the MPLABX Integrated Development Environment (IDE) and load the 

EV92R69A_ck_205.X Motor Driver Evaluation Board firmware project. 
In the “ATA6847.h” file, configure the desired application parameters

4. In the “UserParms.h” file, the desired motor parameters can be configured (see 
Appendix C. “Software”)

5. Build the project
6. Program the device
7. Press the RESET switch on the board to reset the processor and allow it to exe-

cute the new firmware program.

2.3.6 Configuring the ATA6847L
The ATA6847L has configuration registers that may be used to modify the operating 
parameters of the device. The parameters are modified by sending commands to the 
ATA6847L using the SPI communication interface. Bit sampling is performed on the 
falling edge of the clock and data is shifted in/out on the rising edge, as illustrated in 
Figure 2-7. 16 bits must be transmitted to the device for a single register write 

RST ATA6847L reset ' Host
LIN LIN Bus in/output
RX LIN Rx (ATA6847L Out) 
TX LIN Tx (ATA6847L In)
LH Limp Home ATA6847L 
GPIO1 Spare dsPIC test signal (debugging purposes)
GPIO2 Spare dsPIC test signal (debugging purposes)
GPIO3 Spare dsPIC test signal (debugging purposes)
IO1_IA opAmp1 output (current through phase 1)
IO2_IB opAmp2 output (current through phase 2)
IO3_IBus opAmp3 output (current through phases)
M1_IA DIM Internal opAmp output (current through phase 1)
M1_IB DIM Internal opAmp output (current through phase 2)
M1_IBUS DIM Internal opAmp output (current through phase 3)

TABLE 2-4: TEST POINTS DESCRIPTION (CONTINUED)
Test Point Name Description

Note: The following project options may need to be changed for the computer 
used to build the firmware:

• Add Library libdsp-elf.a located in the XC16  ???\src\Libdsp\lib 
directory.

• Add XC16-as ASM. Include Directory in XC16 ???\src\Libdsp\asm.
• Set hardware tool to “PICkit 3”, “PICkit 4”, “PICkit 5” or “REAL ICE”. 
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operation. The first byte contains the 7-bit address along with a 'read/write' bit (the 
LSB). The second byte contains the data to be written to the register. If the R/W bit is 
0, it is a write operation, otherwise a read one.

FIGURE 2-7: SPI Timing Protocol.

The user may add code to the evaluation board firmware to communicate with the 
registers. The evaluation board software contains a subroutine which initializes the 
ATA6847L registers. The configuration registers are summarized in Table 2-5. Detailed 
information is available in the datasheet. An example of waveforms SPI communication 
is shown in Figure 2-8.

FIGURE 2-8: SPI Registers Configuration - Waveform Example.

SCK

MOSI

MISO

nCS

TABLE 2-5: CONFIGURATION MESSAGE COMMANDS (XXXXXXXX = BY DEFAULT)
 Register Address Description Asserted Parameters/Modes

DOPMCR 0x01 Device Operation Mode Control Register

Deep sleep mode
Sleep mode
Standby mode (by default)
Normal mode

LOPMCR 0x02 LIN Operation Mode Control Register
LIN Standby mode 
LIN Normal mode

GOPMCR 0x03 Gate Driver Unit Operation Mode Control 
Register

GDU OFF mode
GDU Standby mode
GDU Normal mode
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2.3.7 ATA6847L Message Responses
When a fault event has occurred, depending on the desired protections that have been 
enabled, the driver generates an interrupt to the host controller by pulling down the 
NIRQ line. At this moment, the host should initiate the SPI communication to read the 
status registers (DSR1, 2) and the system interrupt registers (SIR1...5) and to find out 
the fault cause. Table 2-6 summarizes the registers that should be read.
.

WUCR 0x04 Wake-up Control Register
Local Wake-up Enable
LIN bus remote wake-up enable

GDUCR1 0x05 GDU Control Register 1
BEMF det. enable/disable bit 
Cross conduction enable/disable bit
TCC = 100 ns × N, N = 0 to 63

GDUCR2 0x06 GDU Control Register 2

Edge blanking time control bits
Cross conduction protection time
LSOFF, LS = 0 when GDU = Standby
HSOFF, HS = 0 when GDU = Standby

GDUCR3 0x07 GDU Control Register 3

Low side slew rate control
High side slew rate control
Low side Adaptive dead time
High side Adaptive dead time

GDUCR4 0x08 GDU Control Register 4

VGS under-voltage filter time
VGS/VG UVLO level selection
VGS UVLO detection enable/disable bit
Complementary control enable/disable bit

ILIMCR 0x09 Current Limitation Control Register
Current limit shutdown enable/disable bit
Current limitation filter time
Current limits enable/disable bit

ILIMTH 0x0A Current Limitation Threshold Register VILIM_TH = 5/3.3V/128 × DAC

SCPCR 0x0B Short Circuit Protection Control Register
Short circuit detection threshold
Short circuit filter time
Short circuit shutdown enable/disable bit

CSCR 0x0C Current Sensing OpAmp Control Register

CS OpAmp gain control
CS OpAmp output offset control
Enable CS OpAmp1 enable/disable bit
Enable CS OpAmp2 enable/disable bit
Enable CS OpAmp3 enable/disable bit

TABLE 2-5: CONFIGURATION MESSAGE COMMANDS (XXXXXXXX = BY DEFAULT) 
 Register Address Description Asserted Parameters/Modes

TABLE 2-6: CONFIGURATION MESSAGE RESPONSES
 Register Address Description

DSR1 0x10 Device Status Register 1
DSR2 0x11 Device Status Register 2
SIR1 0x13 System Interrupt Register 1
SIR2 0x14 System Interrupt Register 2
SIR3 0x15 System Interrupt Register 3
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2.4 SCHEMATIC FEATURES

2.4.1 Shunt Topology
The evaluation board is designed in a combined shunt configuration. Two CSAs are 
connected on two of the three phases, while the third is summing all three phases in 
single shunt configuration. See the complete shunt topology used on this board in 
A.2 “EV92R69A – Top Schematic”.
For taking maximum advantage of the part’s features, the evaluation board is config-
ured as illustrated in the picture above, which summarizes the connections between 
external current sense resistors and the internal available CSAs and GDU - External 
MOSFETs bridge. In this configuration, the evaluation board offers the option of evalu-
ating either a combined shunt topology or a single shunt topology. The third CSA can 
monitor the bus current so it can be used for single shunt mode or for limitation of the 
maximum motor current in FOC or Trapezoidal control mode.
Generally, the motor phases are equilibrated, so only two-phase current are required 
to be measured, while the third will be the algebraic sum of the other two. This gives 
the possibility to use the third CSA to evaluate the current pulses across the summing 
shunt. The main advantage is that these pulses are only in positive range related to the 
initial offset and could be directed to the internal current limit comparator, without any 
particular software/hardware processing.

FIGURE 2-9: CSA's Outputs in Combined Shunts Topology.

Finally, by applying the procedure for currents reconstruction, the evaluation board 
offers the possibility to develop and evaluate the single shunt configuration with 
ATA6847L motor driver.

SIR4 0x16 System Interrupt Register 4
SIR5 0x17 System Interrupt Register 5

SIECER1 0x18 System Interrupt Event Capture Enable Register 1
SIECER2 0x19 System Interrupt Event Capture Enable Register 2

TABLE 2-6: CONFIGURATION MESSAGE RESPONSES (CONTINUED)
 Register Address Description
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2.4.2 Asymmetric Turn On/Off External MOSFET Bridge
The evaluation board offers an additional feature, to configure an asymmetric on/off for 
both H/L side external MOSFET bridge by populating R32+D13 and R37+D17 groups 
for all three phases, in order to achieve a slowdown turn-on MOSFET commutation and 
fast commutation of the MOSFET gates to the lowest potential. Furthermore, the part 
could be configured to sink/surge 25%/50%/75% or 100% slew rate speed for LS and 
HS independently.

FIGURE 2-10: Optional Asymmetric Turn On-Off.

2.4.3 Current Sense Amplifier (CSA)
To ensure the ADC range conversion, the initial offset of CSA is set to approximately 
1.65V. The total gain of the CSA is Gt = 16. For high motor currents, it is necessary to 
decrease the equivalent shunt resistor value, in order to avoid CSA output limitation. 
This reduces the losses and avoids analog limitation or overflows in numerical compu-
tation. For sense current detection, the available internal operational amplifiers are 
configured as presented in Figure 2-11, for a high-speed and robust operation of the 
CSA.

FIGURE 2-11: Current Sense Amplifier from ATA6847.
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Appendix A. Schematics and Layouts

A.1 INTRODUCTION
This appendix contains the schematics and layouts of the ATA6847L QFN48 BLDC 
Motor Driver Evaluation Board:
• EV92R69A – Top Schematic
• EV92R69A – DIM
• EV92R69A – IC
• EV92R69A – Buck Converter
• EV92R69A – 3-Phase Inverter
• EV92R69A – USB UART Converter
• EV92R69A – Hall Effect Sensors Connector
• EV92R69A – Speed Potentiometer
• EV92R69A – LIN Interface Connector
• EV92R69A – EEPROM
• EV92R69A – Power Input connector
• EV92R69A – Top Silk
• EV92R69A – Top Copper and Silk
• EV92R69A – Top Copper
• EV92R69A – Bottom Copper
• EV92R69A – Bottom Copper and Silk
• EV92R69A – Bottom Silk
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A.2 EV92R69A – TOP SCHEMATIC
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A.3 EV92R69A – DIM
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A.4 EV92R69A – IC
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A.5 EV92R69A – BUCK CONVERTER
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A.6 EV92R69A – 3-PHASE INVERTER
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A.7 EV92R69A – USB UART CONVERTER

A.8 EV92R69A – HALL EFFECT SENSORS CONNECTOR
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A.9 EV92R69A – SPEED POTENTIOMETER

A.10 EV92R69A – LIN INTERFACE CONNECTOR
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A.11 EV92R69A – EEPROM 

A.12 EV92R69A – POWER INPUT CONNECTOR 

A.13 EV92R69A – INPUT VOLTAGE DIVIDER
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A.14 EV92R69A – NTC THERMISTOR 

A.15 EV92R69A – PUSH BUTTONS

A.16 EV92R69A – VREF OPAMP

VSS

-t

10k
0603
1%

TH1

1k
0603
1%

R95

0.7615V@150°C
1.65V@25°C
3.259V@-20°C

VIO

0R
0603

R113

1
2

1
0

k
N

T
C

T
h

er
m

is
to

r

Jp
14

VSS

TEMP_EXT1

On/Off

ST1
RUN

M1_BUTTON1

47k
R40

0.1uF
C30

VCC

ST2
PB1

47k
R39

0.1uF
C23

VCC

M1_BUTTON2

DGND

DGND

DGND

DGND

DIM_MCLR

47k
R42

10000pF
C31

ST3
RST

VCC

DGNDDGND

VREF

1k

0603
1%

R76

20R

0603
1%

R78

VREF
TP42

1000pF
25V
0603

C1

0.1uF
25V
0603

C16 0.1uF
25V
0603

C2
4.99k
0603
0.1%

R79

4.99k
0603
0.1%

R77

VIO

VCC

0.1uF
25V
0603

C32

VIO

Vin+
3

Vin-
4

VOUT
1

VSS

5

VDD

2

MCP6486R
U6



Schematics and Layouts

 2025 Microchip Technology Inc. and its subsidiaries DS50003904A-page 35

A.17 EV92R69A – TOP SILK

A.18 EV92R69A – TOP COPPER AND SILK
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A.19 EV92R69A – TOP COPPER

A.20 EV92R69A – BOTTOM COPPER
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A.21 EV92R69A – BOTTOM COPPER AND SILK

A.22 EV92R69A – BOTTOM SILK
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Appendix B. Bill of Materials (BOM)

TABLE B-1: BILL OF MATERIALS (BOM)
Qty. Reference Description Manufacturer Part Number
1 C1 Capacitor, ceramic, 1000 pF, 25V, 

5%, C0G/NP0, SMD, 0603
KEMET C0603C102J3GACTU

11 C2, C5, C6, C13, 
C16, C23, C26, 
C30, C32, C33, 
C34

Capacitor, ceramic, 0.1 μF, 25V, 
10%, X7R, SMD, 0603

KYOCERA AVX®, 
AVX Corporation

06033C104KAT2A

2 C3, C21 Capacitor, ceramic, 1 μF, 25V, 10%, 
X7R, SMD, 0805

TDK Corporation C2012X7R1E105K125AB

2 C4, C7 Capacitor, ceramic, 2. μF, 50V, 10%, 
X7R, SMD, 1206, AEC-Q200

Taiyo Yuden Co., Ltd. UMK316B7225KLHT

1 C8 Capacitor, ceramic, 0.1 μF, 100V, 
10%, X7R, SMD, 0805

TDK Corporation C2012X7R2A104K125AA

2 C9, C10 Capacitor, ceramic, 2.2 μF,10V, 10%, 
X7R, SMD, 0603

Taiyo Yuden Co., Ltd. LMK107B7225KA-T

3 C11, C18, C27 Capacitor, ceramic, 0.1 μF, 50V, 
10%, X7R, SMD, 0805

Yageo Corporation CC0805KRX7R9BB104

1 C12 Capacitor, ceramic, 4.7 μF, 16V, 
20%, Y5V, SMD, 0805

Yageo Corporation CC0805ZKY5V7BB475

2 C14, C19 Capacitor, ceramic, 3.3 μF, 25V, 
10%, X7R, SMD, 0805

TDK Corporation C2012X7R1E335K125AB

1 C15 Capacitor, ceramic, 0.33 μF, 50V, 
10%, X7R, SMD, 0805

Samsung 
Electro-Mechanics

CL21B334KBFNNNE

1 C17 Capacitor, ceramic, 4.7 μF, 50V, 
10%, X5R, SMD, 0805

TDK Corporation C2012X5R1H475K125AB

1 C20 Capacitor, ceramic, 0.22 μF, 50V, 
10%, X7R, SMD, 0805

Murata Electronics® GCM21BR71H224KA37L

1 C22 Capacitor, ceramic, 1 μF, 100V, 10%, 
X7S, SMD, 0805

TDK Corporation C2012X7S2A105K125AB

1 C28 Capacitor, ceramic, 220 pF, 50V, 
10%, X7R, SMD, 0603

TDK Corporation C1608X7R1H221K

1 C31 Capacitor, ceramic, 10000 pF, 50V, 
20%, X7R, SMD, 0603

TDK Corporation C1608X7R1H103M080AA

1 C35 Capacitor, ceramic, 10 μF, 50V, 10%, 
X7R, SMD, 1206

Samsung 
Electro-Mechanics 
America, Inc.

CL31B106KBHNNNE

6 C36, C38, C39, 
C41, C42, C44

Capacitor, ceramic, 0.018 μF, 16V, 
10%, X7R, SMD, 0603

KEMET C0603C183K4RAC7867

3 C37, C40, C43 Capacitor, ceramic, 0.068 μF, 16V, 
10%, X7R, SMD, 0603

Panasonic - ECG® ECJ-1VB1C683K

2 CB1, CB2 Capacitor, aluminum, 470 μF, 50V, 
20%, RAD, P5D12.5H20

United Chemi-Con EKZE500ELL471MK20S

Note 1: The components listed in this Bill of Materials are representative of the PCB assembly. The released BOM 
used in manufacturing uses all RoHS-compliant components.
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5 D1, D3, D5, D21, 
D27

Diode, LED, Green, 1.7V, 20 mA. 
3.92 mcd, Diffuse, SMD, 0603

ams-OSRAM AG LP L296-J2L2-25-0-20-R18-Z

9 D2, D4, D6, D20, 
D22, D24, D26, 
D28, D32

Diode, LED, amber, 2.1V, 25 mA, 
2 mcd, clear, SMD, 0603

Lite-On®, Inc. LTST-C190AKT

3 D7, D18, D19 Diode, Zener, PZU15B,115, 15V, 
310 mW, SMD, SOD-323

Nexperia USA Inc. PZU15B,115

4 D8, D29, D30, 
D31

Diode, LED, yellow, 2.1V, 30 mA, 
10 mcd, Diffuse, SMD, 0805

Lumex 
Opto/Components 
Inc.

SML-LXT0805YW-TR

3 D14, D15, D16 Diode, rectifier, array, 1.25V, 200 mA, 
70V, SOT-23-3

Micro Commercial 
Components (MCC)®

BAV99-TP

2 D23, D25 Diode, Schottky, 570 mV,1A, 60V, 
SMD, SOD-123F

STMicroelectronics STPS1L60ZFY

1 FB1 Ferrite, 600R@100 MHz, 300 mA 
SMD 0603

Murata Electronics 
North America, Inc.

BLM18AG601SN1D

1 FB2 Ferrite, 30R@100 MHz, 8.5A, 
AEC-Q200, SMD, 0805

Murata Electronics 
North America, Inc.

BLM21SN300SH1D

1 J1 Connector, EDGE, HTEC8, 0.80 mm, 
120P, female, SMD, vertical

Samtec, Inc. HTEC8-160-01-L-DV-A-K-TR

5 J2, J5, J7, J9, 
J11

Connector, HDR-2.54, male, 1x3, tin, 
5.84 MH, TH, vertical

Samtec, Inc. TSW-103-07-T-S

1 J3 Connector, HDR-2.54, male, 1x8, 
gold, 5.84 MH, TH, R/A

Sullins Connector 
Solutions

PBC08SBAN

1 J4 Connector, terminal, 2.54 mm, 1x5, 
female, 20-30AWG, 6A, TH, R/A

Phoenix Contact 1725685

1 J6 Connector, USB2.0, Micro-B, female, 
SMD, R/A

Amphenol ICC / FCI 101181930001LF

1 J8 Connector, terminal, 2.54 mm, 1x3, 
female, 20-30AWG, 6A, TH, R/A

On-Shore 
Technology, Inc.

OSTVN03A150

1 J10 Connector, terminal, 5.08 mm, 1x2, 
female, 12-28AWG, 16A, TH, R/A

On-Shore 
Technology, Inc.

OSTVI022152

1 J_M Connector, terminal, 5 mm, 1x3, 
female, 12-30AWG, 16A, TH, R/A

Wurth Electronik 691137710003

2 J_MIKRO Connector, header, 8 Position, 0.100" 
(2.54mm) tin, TH

Sullins Connector 
Solutions

PPTC081LFBN-RC

3 Jp11, Jp13, 
JpRst2

Connector, HDR-2.54, male, 1x2, tin, 
6.75MH TH vertical

Molex®, LLC 90120-0122

1 L1 Fixed Inductor, 47 μH, 450 MA, 
834  mΩ

Wurth Electronik 74406032470

1 LABEL1 Label, PCBA, 18x6 mm, Datamatrix, 
Assy#/Rev/Serial/Date

ACT Logimark AS 505462

1 PCB1 Printed Circuit Board — 04-12016-R1
1 PCBA1 PCB Assembly — 02-00943-R1
6 Q1, Q2, Q3, Q4, 

Q5, Q6
Transistor, FET, N-Channel, 60V, 
136A, 0.0023R, 800 mW, VDFN-8

Toshiba 
Semiconductor and 
Storage

TPH2R306NH1,LQ

TABLE B-1: BILL OF MATERIALS (BOM) (CONTINUED)
Qty. Reference Description Manufacturer Part Number

Note 1: The components listed in this Bill of Materials are representative of the PCB assembly. The released BOM 
used in manufacturing uses all RoHS-compliant components.
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12 R1, R2, R3, R4, 
R5, R6, R50, 
R57, R71, R75, 
R86, R87

Resistor, Thick Film, 2k, 1%, 1/10W, 
SMD, 0603, AEC-Q200

Yageo Corporation RC0603FR-072KL

4 R7, R8, R64, 
R65

Resistor, Thick Film, 2.2k, 5%, 
1/10W, SMD, 0603

Yageo Corporation RC0603JR-072K2L

8 R9, R27, R28, 
R29, R44, R45, 
R53, R61

Resistor, Thick Film, 10k, 5%, 1/10W, 
SMD, 0603

Panasonic Electronic 
Components

ERJ-3GEYJ103V

6 R10, R14, R17, 
R24, R31, R35

Resistor, Thick Film, 22R, 1%, 
1/10W, SMD, 0603

Panasonic - ECG ERJ-3EKF22R0V

6 R12, R16, R19, 
R26, R33, R38

Resistor, Thick Film, 120k, 1%, 
1/10W, SMD, 0603, AEC-Q200

KOA Speer 
Electronics, Inc.®

RK73H1JTTD1203F

3 R13, R21, R34 Resistor, Thick Film, 3.3R, 1%, 1/8W, 
SMD, 0805

Vishay® Dale CRCW08053R30FKEA

18 R20, R54, R56, 
R67, R68, R69, 
R70, R72, R73, 
R74, R94, R96, 
R97, R98, R99, 
R100, R101, 
R113

Resistor, Thick Film, 0R, 1/10W, 
SMD, 0603

Vishay Dale, 
Stackpole 
Electronics, Inc.

CRCW06030000Z0EA, 
RMCF0603ZT0R00

4 R30, R58, R59, 
R60

Resistor, Thick Film, 120R, 1%, 
1/10W, SMD, 0603

Stackpole 
Electronics, Inc

RMCF0603FT120R

2 R36, R41 Resistor, Thick Film, 4.7k, 1%, 
1/10W, SMD, 0603, AEC-Q200

Panasonic - ECG ERJ-3EKF4701V

3 R39, R40, R42 Resistor, Thick Film, 47k, 1%, 1/10W, 
SMD, 0603

Panasonic - ECG ERJ-3EKF4702V

1 R46 Resistor, Thick Film, 1.2k, 1%, 
1/10W, SMD, 0603

Stackpole 
Electronics, Inc

RMCF0603FT1K20

1 R47 Resistor, Thick Film, 36k, 1%, 1/10W, 
SMD, 0603

Panasonic - ECG ERJ-3EKF3602V

1 R48 Resistor, Thick Film, 2.7k, 1%, 
1/10W, SMD, 0603, AEC-Q200

Vishay Dale CRCW06032K70FKEA

1 R49 Resistor, Thick Film, 2.4k, 1%, 
1/10W, SMD, 0603

Yageo Corporation RC0603FR-072K4L

1 R51 Resistor, Thick Film, 100k, 5%, 
1/10W, SMD, 0603, (Don't Use, 
Duplicate, Use RSMT0026)

Panasonic - ECG ERJ-3GEYJ104V

1 R52 Resistor, Thick Film, 31.6K, 1%, 
1/10W, SMD, 0603

Panasonic - ECG ERJ-3EKF3162V

2 R62, R63 Resistor, Thick Film, 49.9R, 1%, 
1/10W, SMD, 0603, AEC-Q200

Stackpole 
Electronics, Inc.

RMCF0603FT49R9

2 R76, R95 Resistor, Thick Film, 1k, 1%, 1/10W, 
SMD, 0603

Yageo Corporation RC0603FR-071KL

2 R77, R79 Resistor, Thin Film, 4.99k, 0.1%, 
1/10W, SMD, 0603, AEC-Q200

Panasonic - ECG ERA-3AEB4991V

1 R78 Resistor, Thick Film, 20R, 1%, 
1/10W, SMD, 0603, AEC-Q200

Panasonic - ECG ERJ-3EKF20R0V

TABLE B-1: BILL OF MATERIALS (BOM) (CONTINUED)
Qty. Reference Description Manufacturer Part Number

Note 1: The components listed in this Bill of Materials are representative of the PCB assembly. The released BOM 
used in manufacturing uses all RoHS-compliant components.
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6 R80, R81, R82, 
R83, R84, R85

Resistor, Thick Film, 4.7R, 1%, 
1/10W, SMD, 0603

Yageo Corporation AC0603FR-074R7L

3 RS1, RS2, RS3 Resistor, Shunt, ME, 0.003R, 1%, 
4W, AEC-Q200, SMD, 2512

Vishay Dale WSLF25123L000FEA

1 Rv1 Resistor, variable, 10k, 20%, TH, 
P090S

BI Technologies/
TT Electronics

P090S-14T20BR10K

4 ST1, ST2, ST3, 
SW1

Switch, TACT, SPST, 24V, 50 mA, 
KSR231GLFS, SMD, 6X3.5mm

TE Connectivity 
Alcoswitch Switches

147873-2

1 TH1 Resistor, thermistor, 10k, 1%, SMD, 
0603

TDK Corporation NTCG163JF103FTDS

2 TP1, TP21 Connector, test point, TAB, silver, 
Mini, 3.8x2.03, SMD

Keystone® 
Electronics Corp.

5019

4 TP41, TP-1, 
TP-2, TP-39

Connector, test point, TAB, silver, 
Mini, 3.8x2.03 SMD

Keystone Electronics 
Corp.

5019

TABLE B-1: BILL OF MATERIALS (BOM) (CONTINUED)
Qty. Reference Description Manufacturer Part Number

Note 1: The components listed in this Bill of Materials are representative of the PCB assembly. The released BOM 
used in manufacturing uses all RoHS-compliant components.

TABLE B-2: BILL OF MATERIALS (BOM) – MICROCHIP PARTS
Qty. Reference Description Manufacturer Part Number

1 U1 Analog, Motor Driver, 
UQFN-48

Microchip Technology, Inc. ATA6847T-5033LH/ZWX

1 U2 Memory, Serial EEPROM, 
256K, SPI, TSSOP-8

Microchip Technology, Inc. AT25256B-XHL-T

1 U3 Analog, Switcher, Buck, 2 to 
24V, SOT-23-6

Microchip Technology, Inc. MCP16331T-E/CH

1 U5 Interface, USB, I2C, UART, 
TSSOP-14

Microchip Technology, Inc. MCP2221-I/ST

1 U6 Analog, OpAmp, 1-Ch, 
10 MHz SOT-23-5

Microchip Technology, Inc. MCP6486RT-E/OT

Note 1: The components listed in this Bill of Materials are representative of the PCB assembly. The released BOM 
used in manufacturing uses all RoHS-compliant components.

TABLE B-3: BILL OF MATERIALS (BOM) – MECHANICAL PARTS
Qty. Reference Description Manufacturer Part Number

8 JS1, JS2, JS3, JS4, 
JS5, JS6, JS7, JS8

Mechanical, hardware, jumper, 
2.54 mm, 1x2

Multicomp Pro MC-2228CG

4 PAD1, PAD2, PAD3, 
PAD4

Mechanical, hardware, rubber 
pad, cylindrical flat top, D9.5, 
H4.8, clear

Bumper Specialties BS35CL01X02RP

Note 1: The components listed in this Bill of Materials are representative of the PCB assembly. The released BOM 
used in manufacturing uses all RoHS-compliant components.

TABLE B-4: BILL OF MATERIALS (BOM) – DO NOT POPULATE PARTS
Qty. Reference Description Manufacturer Part Number

0 C24, C25, C29 Capacitor, ceramic, 820 pF, 50V, 
10%, X7R, SMD, 0603

Murata Electronics® GRM188R71H821KA01D

0 D9, D10, D11, D12, 
D13, D17

Diode, Schottky, 40V, 2A, 
SOD-123F

onsemi™ SS24FL

Note 1: The components listed in this Bill of Materials are representative of the PCB assembly. The released BOM 
used in manufacturing uses all RoHS-compliant components.
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0 HS1 Mechanical, hardware, heatsink Advanced Thermal 
Solutions

ATS-CPX050050025-124-C
1-R0

0 J_X Connector, HDR-2.54, female, 
2x10, gold, TH, RT, angle

Sullins Connector 
Solutions

PPPC102LJBN-RC

0 Jp14 Connector, HDR-2.54, male,1x2, 
tin, 6.75 MH, TH, vertical

Molex, LLC 90120-0122

0 R11, R15, R18, R25, 
R32, R37

Resistor, Thick Film, 10R, 1% 
1/8W, SMD, 0805

ROHM 
Semiconductor

MCR10EZHF10R0

0 R22, R23, R55, R66 Resistor, Thick Film, 0R, 1/10W, 
SMD, 0603

Stackpole 
Electronics, Inc.

RMCF0603ZT0R00

0 R43 Resistor, TKF, 10k, 5%, 1/10W, 
SMD, 0603

Panasonic - ECG ERJ-3GEYJ103V

TABLE B-4: BILL OF MATERIALS (BOM) – DO NOT POPULATE PARTS (CONTINUED)
Qty. Reference Description Manufacturer Part Number

Note 1: The components listed in this Bill of Materials are representative of the PCB assembly. The released BOM 
used in manufacturing uses all RoHS-compliant components.
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Appendix C. Software

C.1 SOFTWARE LOCATION
The application software may be downloaded from the ATA6847L webpage located on 
the Microchip website, http://www.microchip.com.

C.2 SELECTED FIRMWARE CONSTANTS AND DEFINITIONS
The desired driver application parameters can be set in “ATA6847L.h” file. Below are 
defined the driver registers and their specific properties.

All required configuration functions are implemented in the “ATA6847L.c” file and can 
be called in the main application function after the power-up sequence.

//**** ATA6847L Application Limit Values settings **************************//
#define VRefDAC         3300    // [mV] or 5000[mV] //
#define CCPT_nS         700     // Cross conduction protection time= 0,100,..6300[nS]
#define EGBLTime_nS     750     // Edge blanking time, 250 (default)
#define AdTSWO_nS       250     // Ad Force time switch, 250 (default)
#define VGSUVFLT_nS     1250    // VGS under-voltage filter time=500..7500, 2000[nS] (default)
#define ILIMFLT_nS      1000    // Current limitation filter time=2000 (default)
#define MOS_OCL         1890    // MOSFET Overcurrent Limit=[0..VRefDAC] [mV]  
#define SCThrVal_mV     250     // Short circuit detection threshold 125mV to 1750mV
#define SCFLT_nS        1000    // Short circuit filter time,2000 (default)

////////////////// Functions conversion prototype ////////////////////////////
inline uint8_t SetCCPTime( unsigned CCPTime );
inline uint8_t Set_VGSUVFLT( unsigned Time_nS );
inline uint8_t TimeConversion( unsigned Time_ns ); 
inline uint8_t SetSCThrVal( unsigned SCThrVal );
inline uint8_t SetCurrLim( long unsigned CurrThrVal );
inline uint8_t SetAd_TSWO( uint8_t Ad_TSWO_ns );

////////////////// Prepare registers content for writing //////////////////////
void ATA6847_Reg_Init(void);

///////////////// Write command, configures register content /////////////////
void    ATA6847_Write_Reg( uint8_t reg_address,uint8_t reg_config );

///////////////// Read command, returns register content ///////////////////////
uint8_t ATA6847_Read_Reg( uint8_t reg_address );

///////////////// Usefull functions ////////////////////////////////////////////
uint8_t     ATA6847_Init_Normal_Mode( void );
void        ATA6847_Init_Standby_Mode( void );
void        ATA6847_Reg_Write_Init_Regs( void );
void        ATA6847_Reg_Read_Init_Regs( void );
inline void ClearFaults( void );
inline void Fault_manage( void );

https://www.microchip.com/
https://www.microchip.com/
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The implementation of the internal ATA6847L registers and bitwise definition can be 
found in the “ATA6847.h” file.

//***************************************************************************// 
//  ATA6847L registers bitwise definition 
//***************************************************************************// 
 
/////////////////////////////////////////////////////////////////////////////// 
#define DOPMCR  (0x01)//    // Device operation mode control register 
////////////////////////////////////////////////////////////////////////////// 
typedef  union { 
    struct{ 
        uint8_t DvOpMd  :3;    // Select Device Operation Mode, Default=1 
        uint8_t         :3;    // Unused (read as 0) 
        uint8_t VdIOOVSD:1;    // Vdd 
                uint8_t RSTLVL  :1;    // Under-voltage (UVDD1 < UVDD1_UV_Set) 
    };  
    BYTE CFG; 
} tDOPMCR;         
  
#define DOpM_DSleep 0b001   //  Deep sleep mode 
#define DOpM_Sleep  0b010   //  Sleep mode 
#define DOpM_St_By  0b100   //  Standby mode (default) 
#define DOpM_Normal 0b111   //  Normal mode   
     
//                                    76543210 
#define DOpM_Sleep_or_DSleep_MASK   0b00000100   
      
/////////////////////////////////////////////////////////////////////////////// 
#define LOPMCR  (0x02)    // LIN TRX operation mode control register 
////////////////////////////////////////////////////////////////////////////// 
typedef union {   
    struct { 
        uint8_t LOPM       :2; // Select LIN Transceiver operation modes            
        uint8_t            :6; // Unused (read as 0) 
    };   
    BYTE CFG;          
} tLOPMCR; 
     
#define LIN_St_By  0b01       // 2'b01  LIN Standby mode (default) 
#define LIN_Normal 0b10       // 2'b10  LIN Normal mode   
                            // Other    Invalid mode selection                      
  
/////////////////////////////////////////////////////////////////////////////// 
#define GOPMCR  (0x03)    // GDU operation mode control register 
/////////////////////////////////////////////////////////////////////////////// 
typedef union {  
    struct { 
        uint8_t GDUOPM     :3;    // Select GDU operation modes                     
        uint8_t            :5;    // Unused (read as 0) 
    };  
    BYTE CFG; 
} tGOPMCR; 
 
#define GDU_OFF     0b001       // GDU OFF mode         1 (default) 
#define GDU_St_By   0b100       // GDU Standby mode     4 
#define GDU_Normal  0b111       // GDU Normal mode      7 
                            // Other Invalid mode selection 
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The configuration functions are called by the ATA6847_Drv_Init() function, as shown 
in following example.

//////////////// Registers content initialization ////////////////////////////// 
// In this function the registers are configured   
// with application required configuration                 
//////////////////////////////////////////////////////////////////////////////// 
void ATA6847_Reg_Init( void )     // Registers content initialization 
{ 
//////////////////// WatchDog-disabling ////////////// 
    ATA6847_REGS.REG_VAL.WDTRIG_CFG.WD_TRIG = 0x55;    //-- valid WWD trigger     
    ATA6847_REGS.REG_VAL.WDCR1_CFG.WDC      = WGD_OFF ; //-- keep WWD off  // WGD_TOM  (default) // 
WGD_WOM 
     
//////////// LIN TRX operation mode control //////////// 
    ATA6847_REGS.REG_VAL.LOPMCR_CFG.LOPM     = LIN_Normal;  //LIN_St_By;// Operation mode 
     
 ///////////// GDU operation mode control ////////////// 
    ATA6847_REGS.REG_VAL.GOPMCR_CFG.GDUOPM   = GDU_OFF;//GDU_Normal;    // Operation mode 
     
///////////// Wake-up control register ////////////////////////// 
    ATA6847_REGS.REG_VAL.WUCR_CFG.LINWUE     = Active;//Inactive;//  // Operation mode 
    ATA6847_REGS.REG_VAL.WUCR_CFG.LOCWUE     = Active;               // Operation mode 
 
//////////// GDU control register 1, Back-EMF, Cross conduction filter time  
   ATA6847_REGS.REG_VAL.GDUCR1_CFG.BEMFEN    = Inactive; 
   ATA6847_REGS.REG_VAL.GDUCR1_CFG.CCEN      = Active; // cross-conduction timer and adaptive dead-
time  
   ATA6847_REGS.REG_VAL.GDUCR1_CFG.CCPT      = SetCCPTime( CCPT_nS ); //  100 {nS] 
    
////////  Edge blanking time, Cross conduction time,/////////////   
 
   ATA6847_REGS.REG_VAL.GDUCR2_CFG.EGBLT     =  TimeConversion( EGBLTime_nS ); 
   ATA6847_REGS.REG_VAL.GDUCR2_CFG.TSWTO     =  SetAd_TSWO( AdTSWO_nS ); 
   ATA6847_REGS.REG_VAL.GDUCR2_CFG.LSOFF     = Active; //Inactive;  // 0, LS=TrS  or 1, LS=0 when 
GDU= Standby 
   ATA6847_REGS.REG_VAL.GDUCR2_CFG.HSOFF     = Active; //Inactive;  // 0, HS=TrS  or 1, HS=0 when 
GDU= Standby 
    
/////////// GDU Control Register 3, Adaptive dead-time, Slew rate 
   ATA6847_REGS.REG_VAL.GDUCR3_CFG.ADDTHS    = AdDT_Dis ;  // Adaptive dead-time HS disabled;   
   ATA6847_REGS.REG_VAL.GDUCR3_CFG.ADDTLS    = AdDT_Dis ;  // Adaptive dead-time LS disabled; 
   ATA6847_REGS.REG_VAL.GDUCR3_CFG.HSSRC     = FullS_50_0; //FullSpeed;//FullS_12_5;//  Slew rate HS 
   ATA6847_REGS.REG_VAL.GDUCR3_CFG.LSSRC     = FullSpeed;// FullS_25_0; //FullS_12_5;// Slew rate LS 
    
////////// GDU Control Register 4 ///////////////////////////UVVGSLVL 
   ATA6847_REGS.REG_VAL.GDUCR4_CFG.VGSUVFLT  = Set_VGSUVFLT( VGSUVFLT_nS ); 
   ATA6847_REGS.REG_VAL.GDUCR4_CFG.UVVGSLVL  = Active;   // VGS/VG under-voltage detection level 
selection(default=1) 
   ATA6847_REGS.REG_VAL.GDUCR4_CFG.UVVGSSEN  = Active;   // VGS under-voltage detection enable, 
default=1) 
   ATA6847_REGS.REG_VAL.GDUCR4_CFG.VDHOVSD   = Active; 
   ATA6847_REGS.REG_VAL.GDUCR4_CFG.COMPEN    = Inactive; // Complementary control enable, default=0 
IL+IH 
//////////// Current limitation control ///////////////////////////    
   ATA6847_REGS.REG_VAL.ILIMCR_CFG.ILIMSDEN  = Active ; 
   ATA6847_REGS.REG_VAL.ILIMCR_CFG.ILIMFLT   = TimeConversion( ILIMFLT_nS ); 
   ATA6847_REGS.REG_VAL.ILIMCR_CFG.ILIMEN    = Inactive; //Active ; 
 
///////// Current limitation threshold //////////////////////////   
   ATA6847_REGS.REG_VAL.ILIMTH_CFG.DAC      = SetCurrLim( MOS_OCL ); 
    
////////////  Short circuit protection /////////////////////////    
   ATA6847_REGS.REG_VAL.SCPCR_CFG.SCTHSEL    = SetSCThrVal( SCThrVal_mV ); 
   ATA6847_REGS.REG_VAL.SCPCR_CFG.SCFLT      = TimeConversion( SCFLT_nS ); 
   ATA6847_REGS.REG_VAL.SCPCR_CFG.SCSDEN     = Active ;//Inactive; // Short circuit shutdown enable 
 
/////////////// Current Sensing OpAmp control register /////////// 
   ATA6847_REGS.REG_VAL.CSCR_CFG.CSAxEN      = CSCR_ALL_CSAX_DISABLED; 
   ATA6847_REGS.REG_VAL.CSCR_CFG.GAIN        = Gain_16;      // Gain=8,16,32,64 0b01     
   ATA6847_REGS.REG_VAL.CSCR_CFG.OFFSET      = VRef_2 ;      // VRef/2/4/8/16, 0b11      
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To write the parameters in the driver, a Write SPI function will be called:

To get a specific register content, a particular read function is implemented.

//////  System Interrupt Mask Register1, activates interrupts ///// 
   ATA6847_REGS.REG_VAL.SIECER1_CFG.OTPWM      = Active;      // Over temperature pre-warning 
   ATA6847_REGS.REG_VAL.SIECER1_CFG.SPIFM      = Active;      // SPI failure interrupt 
   ATA6847_REGS.REG_VAL.SIECER1_CFG.VSUVM      = Active;      // VS UV failure interrupt mask          
(VVS< VVS_UV_Set) 
   ATA6847_REGS.REG_VAL.SIECER1_CFG.ILIMM      = Active;      // Current limitation event 
   ATA6847_REGS.REG_VAL.SIECER1_CFG.VDHOVM     = Active;      // VDH OV failure interrupt 
   ATA6847_REGS.REG_VAL.SIECER1_CFG.GSCM       = Active;  //Inactive// General short circuit failure 
    
//////  System Interrupt Mask Register2, activates interrupts ///// 
   ATA6847_REGS.REG_VAL.SIECER2_CFG.VDD1OVM    = Active;      // VDD1 overvoltage event interrupt  
   ATA6847_REGS.REG_VAL.SIECER2_CFG.VDD2OVM    = Active;      // VDD2 over-voltage event interrupt 
   ATA6847_REGS.REG_VAL.SIECER2_CFG.VDD1UVLM   = Active;      // VDD1 IO under-voltage interrupt     
(VVDD1< VVDD1_IO_UV_Set) event interrupt mask bit 
   ATA6847_REGS.REG_VAL.SIECER2_CFG.VDD1UVHM   = Active;      // VDD1 under-voltage interrupt        
(VVDD1< VVDD1_UV_Set) event interrupt mask bit 
   ATA6847_REGS.REG_VAL.SIECER2_CFG.VDD2UVM    = Active;      // VDD2 under-voltage event interrupt  
    
//////  Init default register with default startup value ////////// 
   ATA6847_REGS.REG_VAL.RWPCR_CFG.CFG = 0x00; 
   ATA6847_REGS.REG_VAL.MLDCR_CFG.CFG = 0x00; 
    
    ////////// Test Device operation mode control  //////// 
    ATA6847_REGS.REG_VAL.DOPMCR_CFG.DvOpMd   = DOpM_Normal;//DOpM_St_By;//  Operation mode 
    ATA6847_REGS.REG_VAL.DOPMCR_CFG.RSTLVL   = Active;//Inactive;    
} 

p
///////////////// Write command, configures register content /////////////////// 
void ATA6847_Write_Reg( uint8_t reg_address, uint8_t reg_config ) 
{ 
    SPI_Command SPI_WORD; 
    SPI_WORD.ADDERSS = reg_address; 
    SPI_WORD.W_R = Write; 
    SPI_WORD.Reg_Config = reg_config; 
    SPI1_Exchange16bit(SPI_WORD.SPI_Command);    
} 

///////////////// Read command, returns register content /////////////////////// 
uint8_t ATA6847_Read_Reg( uint8_t reg_address ) 
{ 
    SPI_Command SPI_WORD; 
    SPI_WORD.ADDERSS    = reg_address; 
    SPI_WORD.W_R        = Read; 
    SPI_WORD.Reg_Config = 0x00; 
    SPI_WORD.Reg_Config = ( uint8_t )(SPI1_Exchange16bit(SPI_WORD.SPI_Command)); 
    return SPI_WORD.Reg_Config;  
} 
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C.3 BLDC USER PARAMETERS

/////***************** HURST Big************************// 
#ifdef  HURST_Big     
#define  NOMINALSPEEDINRPM  3150 
#define  MINSPEEDINRPM      550  // 500             
#define  INITIALTORQUE      1.5              // Initial torque current    
#define  POLEPAIRS          5                 // Number of pole pairs 
#define  PHASERES           ((float)0.35)     // Phase resistance in Ohms. 
#define  PHASEIND           ((float)0.00033)  // Phase inductance in Henrys 
#define  FILTERDELAY        90                // 90-(1...7) advance  
//*** Velocity Control Loop Coefficients ***** 
#define WKP         Q15(0.11751)//Q15(0.3657)// 
#define WKI         Q15(0.01025)//Q15(0.0285)// 
 
/////////////////////////////////////////////////// 
//******** Q Control Loop Coefficients ******* 
#define QKP         Q15(0.09275)//Q15(0.0975)// 
#define QKI         Q15(0.00725)//Q15(0.0095)// 
#define QKC         Q15(0.995) 
#define QOUTMAX     Q15(0.725)  
//******** D Control Loop Coefficients ******* 
#define  DKP         QKP 
#define DKI         QKI 
#define  DKC         QKC 
#define DOUTMAX     QOUTMAX 
 
#define  SMCGAIN        0.525 
#define  MAXLINEARSMC     0.475   // 
#endif     
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C.4 DSPIC33CK256MP205 PORT USAGE

C.4.1 Port's Mapping
Onboard Buttons:

BEMFs/Hall sensors:

C.4.2 A/D Mappings

#define On_Off_Set_Input()   (_TRISD11 = 1) 
#define On_Off_GetValue()    (_RD11) 
#define On_Off               !(_RD11)      //SW1 - BTN_1 
 
#define SPB_Set_Input()     (_TRISE10 = 1) 
#define SPB_GetValue()     (_RE10) 
#define SPB          !(_RE10)      //SW2 - BTN_2 
 

    // Halls or BEMF inputs 
#define BMF_A_SetDigitalInput()  (_TRISC6 = 1) 
#define BMF_B_SetDigitalInput()  (_TRISC7 = 1) 
#define BMF_C_SetDigitalInput()  (_TRISD10 = 1) 
 
#define HallA_SetDigitalInput()  (_TRISD5 = 1) 
#define HallB_SetDigitalInput()  (_TRISD6 = 1) 
#define HallC_SetDigitalInput()  (_TRISD7 = 1) 
 
#define HallA_GetValue()         _RD5 
#define HallB_GetValue()         _RD6 
#define HallC_GetValue()         _RD7 

/**************************************************************************** 
 * Setting the Analog/Digital Configuration SFR(s) 
 ***************************************************************************/ 
ANSELA = 0x0013; 
ANSELB = 0x009F; 
ANSELC = 0x0048; 
ANSELD = 0x0400; 
ANSELE = 0x000F; 
 
I_Bus_SetAnalogInput();// (_ANSELA0 = 1) 
I_B_SetAnalogInput()  ;// (_ANSELA4 = 1) 
I_A_SetAnalogInput()  ;// (_ANSELB2 = 1) 
V_Bus_SetAnalogInput();// (_ANSELC3 = 1) 
SpRef_SetAnalogInput();// (_ANSELC6 = 1) 
//  TempS_SetAnalogInput();// (_ANSELC6 = 1) 

 HallA_SetDigitalInput(); 
 HallB_SetDigitalInput(); 
 HallC_SetDigitalInput(); 
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C.4.3 Communications Mappings

C.4.4 Used Peripherals Mappings

/////// SPI  selection pin -> ATA6847L /////////////////// 
#define nCS_SetOutput()     (_TRISD2 = 0) 
#define nCS                 _LATD2 
#define nCS_Enable()        nCS = 0 
#define nCS_Disable()       nCS = 1    
#define SCK_Set_Output()    (_TRISD12 = 0)  
#define MISO_Set_Input()    (_TRISC4 = 1) 
#define MOSI_Set_Output()   (_TRISC5 = 0)  
////// UART1 pin selection  -> ATA6847L LIN UART /////////    
#define RX_Set_Input()      _TRISC8 = 1 //EvBComb 
#define TX_Set_Output()     _TRISC9 = 0 

/******************************************************** 
 * Set the PPS for used peripherals 
 *******************************************************/ 
__builtin_write_RPCON( 0x0000 );    // unlock PPS 
RPINR20bits.SCK1R = 0x004C;    // RD12->SPI1:SCK1OUT 
RPOR22bits.RP76R = 0x0006;    // RD12->SPI1:SCK1OUT 
RPOR10bits.RP53R = 0x0005;    // RC5->SPI1:SDO1 
RPINR20bits.SDI1R = 0x0034;    // RC4->SPI1:SDI1 
RPINR19bits.U2RXR = 0x004D;   // RD13->UART2:U2RX 
RPOR23bits.RP78R = 0x0003;    // RD14->UART2:U2TX 
__builtin_write_RPCON( 0x0800 );    // lock PPS 
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SOFTWARE

C.5 MPLAB X COMPILER STARTUP
1. Start up the MPLAB X compiler (not supplied, available on the Microchip 

website).
2. From the toolbar, select File>Open Project.
3. Browse to the evaluation board source code path.
4. Select the existing project file named EV92R69A_3Sh_Comb.X.
5. In the Projects window, right mouse-click on EV92R69A_3Sh_Comb.X and 

select Properties. The page contains the project properties. Processor, Compiler, 
Hardware and Config settings may be changed here.

6. Right mouse-click on EV92R69A_3Sh_Comb.X again and select “Make and 
Program Device”. This will compile the firmware and download it to the 
programming hardware.

7. The compiler results will be displayed in the Output window frame. Verify 
success.

C.6 MPLAB X IDE AND PICKIT EXERCISE
1. Start up the MPLAB X (not supplied, available on the Microchip website).
2. From the toolbar, select File>Open Project.
3. Browse to the evaluation board source code path.
4. Select the existing workspace directory named EV92R69A_3Sh_Comb.X or 

create a new one.
5. Connect the C Align Pin 1 of the header with the Pin 1 mark on the programmer.
6. Set the bench power supply voltage control to minimum voltage output.
7. Turn on the power supply and set the output voltage to 13-14V. Turn off the power 

supply.
8. Connect the bench power supply to the evaluation board. Connect +V(14V) to 

J10-1 and -V (Ground) to J10-2.
9. Turn on the power supply.
10. Right mouse-click on EV92R69A_3Sh_Comb.X in the Projects window and 

select “Make and Program Device”. This will compile the firmware and program 
the dsPIC33CK256MP205 processor.

11. The compiler results will be displayed in the Output window frame. Verify 
success.

12. Connect a Brushless DC (BLDC) motor to connector JM (MOTOR). Connect the 
motor phase wires to the PH_A (JM), PH_B (JM), and PH_C (JM) terminals.

13. Momentarily press the RESET switch on the evaluation board. This step is 
required to reset the dsPIC DSC device after programming.

14. Turn the SPEED adjustment fully counterclockwise. This sets the motor to the 
slowest speed.

15. Momentarily press the RUN switch to start the motor.
16. Momentarily press the RUN switch again to stop the motor.
17. Momentarily press the RUN switch again to start the motor.
18. Turn the SPEED adjustment clockwise. The motor speed should increase.
19. You may probe the different test points on the board to see the various signals 

being generated. The GLX, SHX, GHX (X=1..3) test points will show the external 
MOSFET gate drive signals. The D1 through D6 LEDs show the state of the 
PWM inputs to the ATA6847L. 

20. Momentarily press the RUN switch again to stop the motor.
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C.7 MPLAB X DMCI WINDOW EXERCISE
For debugging purposes, in MPLABX IDE there is a plugin tool available that can be 
used as follows:
1. In the open project, use the “UserParms.h” header file, find the line where the 

processor directive //#undef  DMCI_WIN (which undefines the DCMI window) 
is located. Comment that line.

2. In the EV92R69A_3Sh_Comb.c, the sections related to DMCI will become 
active.

3. Find the section where the desired variables are assigned to the DMCI declared 
vectors. For example, see the variables below:

4. The PICkit should be attached at the J3 evaluation board connector.
5. From the toolbar, select Debug->Debug Project. Wait for compilation and 

debugging to launch and run.
6. After successful project compilation and board programming, press the RUN 

button and increase the speed at around 80% from full scale. Stop the motor by 
pressing again the RUN button.

7. Stop the debugging by pressing the Pause button or <Ctrl+Alt+8>.
8. From the toolbar, select Tools->Embedded->DCMI-> DCMI Window.
9. In Dynamic Data View right click on each Data Source window and assign one 

of DMCI_WIN1[ ] to DMCI_WIN 4[ ] vectors for each of Data Source windows. In 
each Data Source window, the evolution of the assigned variable will appear. By 
merging all Data Source windows, all data can be displayed on the same graph, 
as illustrated below:

10. Notice that, after closing the debugging session, the board must be 
reprogrammed with the #undef DMCI_WIN line uncommented, as described 
above, in the C6 section, in the desired motor control mode.

#ifdef DMCI_WIN             // For test pourposes              
DMCI_WIN1[indx]= SMO_est.Ealpha;//AngleEst.CurrTheta;//IPh.a;//
DMCI_WIN2[indx]= SMO_est.Ebeta;//IPh.b;//I_Ph_Comp.qIb;//
DMCI_WIN3[indx]= I_Alpha_Beta.alpha;//I_ADC.c;//  
DMCI_WIN4[indx]= I_Alpha_Beta.beta;//Sp_Ref.qValue;//
indx++;
if(!(indx<WIN_DIM))
{indx=0;}

#endif  
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